Session Two: Doing Useful
Work with Excel

Only those who have the patience to do simple things perfectly ever
acquire the skill to do difficult things easily.

Unknown authors

Now that you’ve mastered the basics you are ready to do really useful
work with this amazing tool. In this session you will learn to use all of
Excel’s basic features properly. This will put you way ahead of anybody
that hasn’t been formally trained in Excel best practice. You'll be doing
simple things, but you'll be doing them perfectly!

Even after years of daily use many users are unable to properly use
Excel’s fundamental features. They often reach their goal, but get there in
a very inefficient way simply because they were never taught how to do
things correctly. By the end of this session you'll be astonished with how
well you are working with Excel. What originally seemed like a baffling
array of little colored buttons will suddenly all begin to make sense.

Session Objectives

By the end of this session you will be able to:
Enter text and numbers into a worksheet
Create a new workbook and view two workbooks at the same time
Use AutoSum to quickly calculate totals
Select a range of cells and understand Smart Tags
Enter data into a range and copy data across a range
Select adjacent and non-adjacent rows and columns
Select non-contiguous cell ranges and view summary information

Re-size rows and columns
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|
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|

|

|

B Use AutoSum to sum a non-contiguous range

B Use AutoSum to quickly calculate averages

B Create your own formulas

B Resize a column and create functions using Formula AutoComplete
B Use AutoFill for text and numeric series

B Use AutoFill to adjust formulas

B Use AutoFill Options

B Speed up your AutoFills and create a custom fill series
B Use the zoom control

|

Print out a worksheet
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Lesson 2-1: Enter text and
numbers into a worksheet

Excel beginners tend to reach for the mouse far too often. One of the keys
to productivity with Excel is to avoid using the mouse when entering
data. In this lesson we’ll quickly populate a worksheet without using the
mouse at all.

1

tip
Entering numbers as
text

Sometimes you need Excel to
recognize a number as text.

If you type an apostrophe ()
first, Excel won’t display the
apostrophe but will format the
cell as text. You'll notice that
the number is then left justified
to reflect this.

When a number is formatted as
text you cannot perform any
mathematical calculation with it.

note

Very few Excel users will make

il

use of the Cancel and Enter

i
bar.

buttons on the formula

The Enter button is the only
method that will save a value
into a cell without moving the
cursor away from the cell.

This is very useful during macro
recording — an expert skill that is
outside the scope of this book
but is covered in the Excel Expert
Skills book in this series.

First Quarter Sales and
Profit

Open the Sample file: First Quarter Sales and Profit.

A B C D
1 Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar
4 |New York 22,000 29,000 15,000
5 |Los Angeles
6 London
7 Paris
8 |Munich

Notice the difference between values and text.

Cells can contain values or text. Values can be numbers, dates or
formulas (more on formulas later).

Excel usually does a great job of recognizing when there are values
in a cell and when there is text. The giveaway is that text is always
(by default) left aligned in the cell and values are right aligned.

Look at the numbers on this worksheet. Notice how they are all
right aligned. This lets you know that Excel has correctly
recognized them as values and will happily perform mathematical
operations using them.

Save a value into a cell.

1. Type the value 42000 into cell B5. Notice that the mouse cursor
is still flashing in the cell.

420004

At this stage the value has not been saved into the cell.

If you change your mind, you can still undo the value by
pressing the <ESC> key at the top left of your keyboard or by

"

clicking the Cancel button on left hand side of the Formula

Bar.

2. Decide that you want to keep this value in the cell by either
pressing the <Enter>, <Tab> or an <Arrow> key on the

"

on the

keyboard, or by clicking the Confirm button
Formula Bar.

Enter a column of data without using the mouse.

When you enter data into a column there’s no need to use the
mouse. Press the <Enter> key after each entry and the active cell
moves to the cell beneath. Try this now with the following January
sales data:
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Important

The many ways of
entering numbers

Negative numbers

-123.56
(123.56)

Currency prefixes

Excel is quite happy for you to
prefix a number with a currency
symbol. The currency symbol it
will accept depends upon how
you defined the regional options
in your operating system.

$123.56 (works in USA)
£123.56 (works in UK)

See Lesson 4-3: Format numbers
using built-in number formats for
an easy method of setting $, £
and € currency prefixes
whatever your locale.

Commas

12,234,567.78

Fractions

You must leave a space between
a number and a fraction for this
to work.

61/4
(six, space, one, /, four)

The above will appear on the
worksheet as 6.25 after you
enter it in this way.

01/4
(zero, space, one,/,four)

The above will appear on the
worksheet as 0.25. The leading
zero is needed to prevent Excel
from thinking that you are
entering a date.

Formula Blar

- Je | January '

B C D
t Report - First Quarter 2003

IJanuaE _IFeb Mar

22,000 29,000 19,000
42,000 39,000 43,000 |

Sheet? -~ Sh[i[H I o

m = e

ﬂ@lm@ 0 @

1. Type 18,000 into cell B6
2. Press the <Enter> key to move to cell B7.

3. Do the same to enter the relevant values into the next two cells.

3 Jan Feb Mar

4 Mew York 22,000 29,000 19,000
5 |Los Angeles 432,000

& London 13,000

7 |Paris 35,000

8 Munich 12,000

Enter a row of data without using the mouse.

When you enter a row of data you also don’t have to use the
mouse.

1. Click in Cell C5.
2. Type 39,000 and then press the <Tab> key on your keyboard.

The Tab key is on the left hand side of the keyboard above the
<Caps Lock> key. Notice how pressing the <Tab> key saves the
value into the cell and then moves one cell to the right.

3. Type 43,000 in cell D5 and press the <Enter> key.

4. You magically move to cell C6 as Excel assumes you want to
begin entering the next row.

Complete the table without using the mouse.

By using the <Tab> or <Enter> key in the right place you should be
able to complete the table now without using the mouse:

A B C D
3 Jan Feb Mar
4 |MNew York 22,000 29,000 19,000
5 Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000

Change the text in cell B3 to January.

1. Double-click cell B3. Notice that there is now a flashing cursor
in the cell.

Jan

2. Type uary on the keyboard to change Jan to January.
3. Press the <Enter> key.
Change the text in cell B3 back to Jan using the formula bar.

Click once in cell B3 and then change the text in the formula bar
(see sidebar).

Save your work as First Quarter Sales and Profit-2.
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tip
Other way of creating
a new workbook

e  Use the keyboard shortcut
<Ctrl>+<N>.

e Add a button to the Quick
Access Toolbar.

See more details of how this is
done in: Lesson 1-10: Customize
the Quick Access Toolbar and
preview the printout.

note

What are templates?

The vast majority of users
know nothing about templates
and simply base every
worksheet upon the Blank
Workbook default template
supplied by Microsoft.

The Blank Workbook template
has no information in the
worksheet itself, but contains
all of the Excel Option settings
such as the default font size
and type.

Templates can also contain
anything that a worksheet can
contain and are used to store
worksheet frameworks to give
you a flying start when you
find that you often create very
similar worksheet layouts.

If you explore the New
Workbook dialog a little more
you'll see that there are
hundreds of pre-built templates
provided by Microsoft.

Later in this book, in

Lesson 3 12: Create a template
you'll learn how to create your
own template library to
personalize the appearance of
your workbooks.

Lesson 2-2: Create a hew
workbook and view two
workbooks at the same time

1 Create a new workbook by opening Excel

The easiest way to create a new workbook is to simply open Excel.
Excel helpfully creates a workbook, unimaginatively named
Bookl. If you already have a workbook open called Book1, the new
workbook will be called Book2... and so on.

Open Excel now and see this in action. Notice that Book1 — Microsoft
Excel is displayed on the Title Bar.

(™ = a - Bookl - Microsoft Excel

- Home | Insert Page Layout  Formulas Data Revie AddlIns @ - = X

== ¥ ||calibri -l - X - A7~
Pai i B Cells -_j]' i
e 7 |[ETo-AT] |2 2= o
Clipboard ™ Font {F] Alignment {F] Editing
| Al - e |
I A B C D E F G H I%I

[ 1

2

2  Create another new workbook.
You wouldn’t want to have to open and close Excel every time you

needed a new workbook.

1. Click the Office button = at the top left of the screen and
click the New button on the dialog:

A | 3 A =
- A

)

2. The New Workbook dialog is displayed:

Mew Workbook @

Templates i Se:l | | Blank Workbook
Blank and recent

Installed Templates Blank and rec...

My templates... i

m

m

Mew from existing...

Microsoft Office Online

Featured Blank Workbook
Agendas

Budgets

Calendars

Expense reports

3. Double-Click the Blank Workbook template. A new blank
workbook called Book2 is displayed in the workbook window.
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note

Finding a workbook
when many are open

An alternative way to quickly
find a workbook when many
are open is to click
View—>Window->Switch
Windows.

This presents you with a list of
all open workbooks.

Save Switch Macrd

Workspace 'Windows = B4
" v | 1Book2
2 Bookl

You can also use the
<Ctrl>+<Tab> keyboard
shortcut to cycle through all
open workbooks.

£5 Mew Window [ Split
= Arrange All| T Hide

i Freeze Panes ~ ] Unhide

Windo

Arrange All

Tile all open program windows
side-by-side on the screen.

Arrange Windows | 7 |[=23%]

Arrange

(7 Tiled

(7 Cascade

[] windows of active workbook

[ OK ]’ Cancel ]

You could be forgiven for thinking that nothing has happened but
you can see that the Title Bar now says: Book2 — Microsoft Excel,
showing that you are now looking at a different workbook.

See the What are templates sidebar for more information about
templates.

Use the buttons on the taskbar to move between workbooks.

You’ll see two buttons on the taskbar at the bottom of the screen:

W

Click on the buttons to show each workbook in the worksheet
window. The only difference you will see is the Title Bar changing
from Book1 to Book2 because both workbooks are empty.

See the sidebar for other methods of switching windows.

Show both Bookl and Book2 in the worksheet window at the
same time.

This skill often draws a gasp of amazement from my students.
Believe it or not, most Excel users don’t know how to do this.

1. Click View>Window->Arrange All. The Arrange Windows
dialog is displayed.

2. Choose the Horizontal arrangement and click the OK button.

Both workbooks are now shown within the workbook window:

’ :_a\ (= _lé o Microsoft Excel - = X
o =
—j Home Insert Page Layout Formulas Data Review View LZ]
"—:I % calibri - |11 o, Allls) == a7 -

Zy (B uw ~|[A° &7l - - da-
Pa'ste f (i mIpes éﬂ = NuTber Sty;les Ce'IIs G-
Clipboard ™ Font (P Alignment (P Editing
| AL ~( |
h?‘i] Book2 = ] x
A B C D E F G H

1

2

M+ » M| Sheetl  Sheet? - Sheet3 -~ ¥ [ [—TE— 0.
A B C D E F G H

1

2

4 4 » ¥ | Sheetl  Sheet?2 - Sheetd  ¥J

Ready EEEEST NS === Es

Notice that as you click each workbook window the title bar lights
up and the Close/Minimize/Restore Down buttons appear, to show
that this is the active workbook.

Close Book2 and Maximize Book1 to restore the display to a
single workbook.

If you've forgotten how to do this, refer back to: Lesson 1-3:
Understand the Application and Workbook windows.
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anecdote

I ran an Excel course for a small
company in London a couple of
years ago.

The boss had sent his two office
staff to learn a little more about
Excel.

Before the course began I asked
the delegates how long they had
been using Excel. They told me
that they’d been using it for two
years to do all of their office
reports.

When I showed them AutoSum
they gasped in delight. “This
will save us hours” they told
me.

I'was curious how they had
been doing their reports before.

Believe it or not, they had been
adding up all of the figures in
each column with a calculator
and then manually typing the
totals at the bottom of each
column.

In this case the boss had given
them Excel as he had heard it
was very good. Unfortunately
he had not initially seen the
need to train the staff in its use.

With no training it seemed quite
logical to them to use it like a
word processor and the boss
had still been delighted that his
staff were using such impressive
technology.

First Quarter Sales and
Profit-2

Lesson 2-3: Use AutoSum to
quickly calculate totals

Excel’s AutoSum feature is a really useful and fast way to add the values
in a range of cells together.

1

2

Open First Quarter Sales and Profit-2 from your sample files
folder (if it isn’t already open).

In cell A9 Type the word Total followed by the <Tab> key.

The cursor moves to the right and is now in cell B9:

7 | Paris 35,000 26,000 31,000
2 |Munich 12,000 15,000 13,000
9 Total 1

Click Home->Editing-> (this is the Autosum button).

Autosum
Button

j Sort & Find &
<2 Filter~ Select~

Editing

Something interesting has happened to the worksheet:

A B C D
3 Jan Feb Mar
4 New York : EE,DDD-'? 29,000 15,000
5 |Los Angeles E 42,000 j 39,000 43,000
6 London : 18,000 E 20,000 22,000
7 |Paris E 35,000 ¢ 26,000 31,000
& Munich L,,,,]'E'DDDJ% 15,000 13,000
9 Total =5UM Elﬁ
10 | | SUPvﬂl{l‘numb];r‘I [number?], ... |

Excel has placed a marquee around the number range that
AutoSum has guessed we want to work with. The pattern of dots
that marks the boundary of the marquee is called the marching ants
(that really is the technical term for them)!

The marching ants surround all of the numbers in the column
above, up to the first blank cell or text cell (in this case, up to the
word Jan).

=Sum(B4:B8) is your first glimpse of an Excel Formula. Formulas
always begin with an equals sign. This formula is using the SUM

function to compute the Sum (or total) of the values in cells B4 to

BS.

62

www.LearnMicrosoftExcel.com



Session Two: Doing Useful Work with Excel

tip
Entering an AutoSum

using only the
keyboard

You can also execute an
AutoSum using the keyboard
shortcut:

<Alt>+<=>.

4

v

Press the <Enter> key or click the AutoSum button Z once
more to display the total January sales:

A B C D

3 Jan Feb Mar

4 New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
S Total 129,000

Type the word Total in cell E3 and press the <Enter> key
once.

The cursor moves down one row and is now in cell E4.

B C D E
3 |lan Feb Mar Total
4 22,000 29,000 19,000 |
b 42,000 39,000 43,000

Use AutoSum to calculate sales for January..

1. Click Home->Editing-> AutoSum.

This time AutoSum correctly guesses that you want to sum the
values to the left of cell E4:

B C D E
3 Jan Feb Mar Total
4t o000 29,000 19,000 |=suM(Euem |
5 42,000 39,000 | SUM(numberl, [number?], ...)
] 18,000 20,000 22,000

2. Press the <Enter> key, or click the AutoSum button once more.

.
-"ﬁ:;\‘- =, R 5 First Quarter Sales and Profit-2.adsx - M - = x
Home | Insert | Page || Formi | Data | Reviel | View | Devel: | Add-IlI'-@;' - =7 X
| 17 - I | ¥
A B C D E K
1 Sales and Profit Report - First Quarter 2008
2 =
3 Jan Feb Mar Total 3
4 New York 22,000 29,000 19,000 70,000
5 |Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 |Total 125,000
4 4 » M| Sheetl ~Sheet? ~Sheetd % m |
Ready | 5 U| 100% (=) 0 (F) s

Save your work as First Quarter Sales and Profit-3.

© 2008 The Smart Method Ltd
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8 Munich 12,000
9 |UsSA sales

10

First Quarter Sales and
Profit-3

Lesson 2-4: Select a range of
cells and understand Smart
Tags

Sometimes you don’t want to add all of the values in a column. You only

want to add a selection of cells that you define yourself.

This lesson shows you how to do this with a different AutoSum
technique.

1 Open First Quarter Sales and Profit-3 from your sample files
folder (if it isn’t already open).
2 Observe the formula behind the value in cell B9.

Click on cell B9 or move to it with the arrow keys on your
keyboard.

Look at the formula bar at the top of the screen. Notice that the cell
displays the value of a calculation and the formula bar shows the
formula used to calculate the value:

B9 - fx | =sum(B4:B8)
A B C D
2 Munich 12,000 15,000 13,000
9 Total 129,000
| |
10
n Value Formula

3 Delete the contents of cell B9.

The easiest way to delete the contents of a cell is to press the
<Delete> key on your keyboard but you can also right-click the cell
and then click Clear Contents from the shortcut menu.

4 Change the word Total in cell A9 to USA Sales and press the
<Tab> key once.

You don’t have to delete the word Total before typing USA Sales.
When you click in a cell and immediately begin to type, the
existing cell contents are replaced.

The cursor moves to cell B9.
5  Select cells B4:B5 with your mouse.

When the mouse cursor hovers over a cell there are three possible
cursor shapes:
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note

Selecting cells with
the keyboard

To select cells with the keyboard
hold down the <Shift> key and
then use the <Arrow> keys to
select the range needed.

note

Selecting a large
range of cells with the
<Shift>-click
technique

If you need to select a very large
range of cells it is sometimes
useful to use this technique:

1.  Click the cell in the top left
corner of the required
range.

2. Use the scroll bars to move
to the bottom right corner
of the required range.

3. Hold down the <Shift> key.

4. Click in the bottom right
corner of the required
range.

@ | 64,000 |

Cursor ‘ What it does

L1.6 The white cross (Select) cursor appears when
" you hover over the centre of the cell. You can
then click and drag to select a range of cells.

I 1E1|.I The black cross (AutoFill) cursor appears

when you hover over the bottom right-hand
corner of a cell. We’ll be covering AutoFill
later in this session.

1.6 The four headed arrow (Move) cursor appears
—#& when you hover over one of the black edges of

the cell (but not the bottom right corner).
|

Formula Omits Adjacent Cells
Update Formula to Include Cells
Help on this error

Ignaore Error

Edit in Formula Bar

Error Checking Options...

Beginners often have difficulty selecting cells and end up moving
them or AutoFilling them by mistake.

Position the mouse at the centre of cell B4 so that you see the White
Cross (select) cursor. When you see the white cross, hold down the
left mouse button and drag down to cell B5.

You have now selected cells B4 and B5 (in Excel speak we say that
you have selected the range B4:B5).

Jan
MNew York 22,000 |
Los Angeles 45&_

Click the Autosum button. z

USA sales are shown in cell B9. Notice the small green triangle at
the top left of B9. This is Excel’s way of saying: “I think you may
have made a mistake”.

3 USASales 64,000

Select cell B9 and you will see an Exclamation Mark icon. This is
called a Smart Tag.

Hover over the Smart Tag.

A tip box pops up telling you what Excel thinks you may have
done wrong (see below). Of course, in this case, everything is fine.
The Smart Tag thinks that perhaps we didn’t want just the USA
sales — but the Smart Tag is mistaken!

USA Sale G - I 64,000 _|

|Thef0rmu|a in this cell refers to a range that has additional numbers adjacent to it.|

Examine the remedial actions suggested by the Smart Tag.

Click the drop-down arrow next to the exclamation mark icon. A
list of possible remedial actions is displayed. In this case you can
choose Ignore Error to remove the green triangle from the corner of
the cell.

Save your work as First Quarter Sales and Profit-4.
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Lesson 2-5: Enter data into a
range and copy data across a
range

Now that you have mastered the technique of selecting cells, you can use
it to speed up data entry.

When you select a range of cells prior to entering data, Excel knows that
all data entered belongs in that range. Several key combinations are then
available to greatly speed up data entry.

1 Open a new workbook and save it as Data Range Test.
2  Select cells B2:D4.

A B £ D E

B

ok w R

3  Type London.
The text appears in Cell B2, the top left cell in the range selected.
4 Press the <Enter> Key.
The cursor moves to cell B3 as it normally would.
5  Type Paris followed by the <Enter> key.
The cursor moves to cell B4 as it normally would.
6 Type New York followed by the <Enter> key.

This time something new happens. The cursor doesn’t move to cell
B5 as you might expect but jumps to cell C2.

A B C D E m
: g
2 London
3 Paris
4 Mew York
5 -

7  Type 150,000 followed by the <Enter> key.

The value appears in C2 and Excel moves down the column again

to cell C3.
A B c D E m
! =
2 London 150,000
3 Paris
4 Mew York 1
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10

11

12
13

14

Press the <Enter> key without entering a value to leave C3
blank.

Excel moves down the column to cell C4.
Type 225,000 followed by the <Enter> key.
The cursor jumps to cell D2.

Press <Shift>+<Enter> twice to change your mind about
leaving Paris blank.

1. Press <Shift>+<Enter> to move backwards to New York sales.

2. Press <Shift>+<Enter> a second time and you are back to the

Paris cell.

A B C D E m
L E
2 London 150,000
3 Paris
4 New York 225,000 1
5

Type 180,000 followed by the <Tab> key.

<Tab> moves you across the range, to cell D3.

A B C D E

London 150,000
Paris 180,000
MNew York 225,000

L R

You can now appreciate how to use this technique of <Enter>,
<Tab>, <Shift>+<Tab> and <Shift>+<Enter> to save a lot of time
when entering a whole table of data.

Select cells D2:DA4.
Type 50% but don’t press the <Enter> or <Tab> keys.

The challenge this time is to place the same value into cells D3 and
D4 without having to type the value two more times.

Press <Ctrl>+<Enter>.

The value is replicated into all of the other cells in the range.

A B C D E T
1 B
2 London 150,000 50%
3 Paris 180,000 50%
4 MNew York 225,000 5{#%.
5
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Lesson 2-6: Select adjacent
and non-adjacent rows and
columns

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2  Select all of column A

Hover over the letter A at the top of the column. The button lights
up and the mouse cursor changes to a black down arrow:

I B C

1 Sales and Profit Report - First Quarter 2008

Click to select the entire column. The column becomes slightly
shaded and a black line surrounds all of the cells.

A B
1 |Sales and Projit Report - Fir
2
3 Jam
4 |New York 22,000

3 Click Home—>Font->Bold to bold face the column.

Because the whole column was selected, all of the values become
bold faced.

4 Click Home—->Font->Bold once more to change the type back
to normal.

5  Select all of row 4.

To select a row, hover over the number on the left hand side of the
row. The button lights up and the mouse cursor changes to a black
arrow pointing across the row:

3 Jan
= |[Mew York 22,000
5 Los Angeles 42,000

Click to select the row.
6  Select columns B and C.

Hover over the letter at the top of column B until you see the black
down arrow. When you see the arrow, click and drag to the right
to select both columns.

First Quarter Sales and
Profit-4
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A B c D
1 Sales and Proyit Report - First Quarter 2
2
3 Jan Feb Mar
4 Mew York 22,000 29,000 19,000

7 Select rows 6 and 7.

Hover over the number at the left of row 6 until you see the black
arrow pointing across the row. When you see the arrow, click and
drag down to row 7 to select both rows.

5 |Los Angeles 42,000 39,000
6 [London 18,000 20,000
=/ |Paris 35,000 26,000
2R || Munich 12,000 15,000

8  Select columns A, B, C, D and E.

Sometimes you will need to select a large number of adjacent
columns or rows. You could drag across them but it is often easier
to use the following technique:

1. Select Column A.
2. Hold down the <Shift> key.
3. Select Column E.

Columns A to E are selected.

1 [Sales and Profit Report - First Quarter 2008

9  Select rows 4 and 6.

Perhaps you need to perform an operation on two non-adjacent
rows. To select rows 4 and 6 you need to:

1. Select row 4.
2. Hold down the <Ctrl> key on the keyboard.
3. Select Row 6.

3 | Jan Feb Mar
New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
lLondon 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
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Lesson 2-7: Select non-
contiguous cell ranges and
view summary information

Contiguous is a very impressive word! It simply means a range of cells
that is split across two blocks of cells in different parts of the worksheet.

Non-contiguous ranges can be selected using both the mouse and
keyboard. The keyboard method may seem a little involved at first but
you’ll find it much faster once you have the hang of it.

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2 Select the contiguous range B4:D8 with the keyboard.

When you need to select a contiguous range with the keyboard
here’s how it’s done:

1. Use the arrow keys on the keyboard to navigate to cell B4
2. Hold down the <Shift> key on the keyboard

3. Still holding the <Shift> key down, use the arrow keys on the
keyboard to navigate to cell D8

The contiguous range B4:D8 is selected.

< E

1 |Sales and Profit Report - First Quarter 2008

2

3 Jan Feb Mar Total
New York 22,000 29,000 19,000 70,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000

| 9 | USA Sales 64,000

3 Select the non-contiguous range B4:B8,D4:D8 using the
mouse.

1. Select the range B4:B8.
2. Hold down the <Ctrl> key and select the range D4:D8.
The non-contiguous range B4:B8,D4:D8 is selected:

L~ T T ¢ [ho ] e T

1 |Sales and Profit Report - First Quarter 2008

3 Jan Feb Mar Total
New York 22,000 29,000 | 19,000 | 70,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000

First Quarter Sales and 9 |USA Sales 64,000
L 1

Profit-4
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4 Select the same non-contiguous range with the keyboard.

This is a little more involved than using the simple
<Shift>+<Arrow keys> method used earlier.

Here’s how it’s done:
Use the arrow keys on the keyboard to navigate to cell B4
Press the <F8> key (it is on the very top row of your keyboard)
Use the arrow keys to navigate to cell B8

Press <Shift>+<F8>

1
2
3
4
5. Use the arrow keys to navigate to cell D4
6. Press <F8>

7. Use the arrow keys to navigate to cell D8
8. Press <Shift>+<F8> one last time

The non-contiguous range B4:B8,D4:D8 is selected:

-~ [Te ] ¢ [l e

1 |Sales and Profit Report - First Quarter 20028

2

3 Jan Feb Mar Total
New York 22,000 29,000 | 19,000 | 70,000
Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000

| 9 | USA Sales 04,000

5 Obtain a total sale figures for January and March using the

status bar.
The status bar contains summary information for the currently

71 average =it selected range.

v | count 10 Look at the bottom right of your screen. You can see the average
- sales and total sales (sum of sales) for January and March:
Mumerical Count

v | Minimum 12,000 Average: 25,700 Count: 10 Sum: 257,000

v | Maximum 43,000

v || Sum 257000 © View the Maximum and Minimum sales for January and

71 view shorteuts March using the status bar.

v | Zoom 100% Right-click the status bar and click Maximum and Minimum on the

/ ; i pop-up menu (see sidebar).

Zoom Slider

The status bar now also displays Maximum and Minimum values.

Average: 25,700 Count: 10 Min: 12,000 Max: 43,000 Sum: 257,000

7 Close the workbook without saving.
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Sales Report

Lesson 2-8: AutoSelect a

range of cells

When data is arranged in a block (as it is in the Sales and Profit Report) it
is referred to as a range (in previous versions of Excel it used to be called

a list).

You will often want to select a row or column of
even the entire range.

cells within a range, or

You can select ranges by using any of the techniques covered so far but
this could be very time consuming if the range encompassed thousands

of rows and columns.

In this lesson you’ll learn how to select range rows, range columns and

entire ranges with a few clicks of the mouse.

1 Open Sales Report from your sample

files folder.

This report contains a range of cells. The range is the block of cells

from A3 to E19.
A B c D E f
1 |Weekly Sales Report
2
3 |Invoice No Date Customer Country  Total
4 10918 10 March 2008 Bottom-Dollar Markets Canada 1,700.81
5 10917 10 March 2008 Romero y tomillo Spain 439.92
6 10926 10 March 2008 Ana Trujillo Emparedados y helados Mexico 604.42
7 10929 11 March 2008 Frankenversand Germany = 1,380.33
3 10934 11 March 2008 Lehmanns Marktstand Germany 587.50
9 10939 11 March 2008 Magazzini Alimentari Riuniti Italy 749.05
10 10939 11 March 2008 Magazzini Alimentari Riuniti Italy - 749.05 =
11 10925 12 March 2008 Hanari Carnes Brazil 558.29
12 10944 12 March 2008 Bottom-Dollar Markets Canada 1,204.73
13 10923 12 March 2008 La maison d'Asie France 879.83
14 10937 13 March 2008 Cactus Comidas para llevar Argentina 757.64
15 10947 13 March 2008 B's Beverages UK 258.50
16 10933 13 March 2008 Island Trading UK 1,081.71
17 10938 14 March 2008 QUICK-Stop Germany  3,209.95
18 10949 14 March 2008 Bottom-Dollar Markets Canada 5,195.85
19 10945 14 March 2008 Morgenstern Gesundkost Germany 287.88 _|
20 k
21 |Thsi report excludes sales to Asia and South Africa. Range

272
4 4 » #| Sheetl Sheet2 ~Sheetd -~ ¥1 ]

m B |

2 Select all cells within the range to the right of cell A7.

1. Click in cell A7 to make it the active cell.

2. Hover over the right hand border of cell A7 until you see the
four headed arrow cursor shape.

7 109 2“5%1

8 10934 17

3. When you see this cursor shape hold down the <Shift> key
and double-click.

All cells to the right of A7, but within the range, are selected.

7 10929 11 March 2008 Frankenversand Germany  1,380.33

12
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note

Other ways to use
AutoSelect

Using the keyboard.

Here’s how you would select
the entire range in the Weekly
Sales Report (including the
header row) using the keyboard
method.

Make cell A3 the active cell by
navigating to it with the
<Arrow> keys.

1. Press:

<Ctrl>+<Shift>+
<DownArrow>

Cells A3:A19 are selected.
2. Release all keys and press:

<Ctrl>+<Shift>+
<RightArrow>

The entire range (including
the header row) is selected.

From the Ribbon.

The Ribbon method isn’t as
powerful as the other methods
but does provide a way to select
the current range (described as
the region in the dialog).

Make sure that the active cell is
within the range.

1. Click

Home->Editing>
Find & Select>
GoTo Special...

The GoTo Special dialog is
displayed.

2. Click the Current Region
option button and then
click the OK button.

The entire range (including the
header row) is selected.

3

4

Select all cells within the range except the header row.
1. Click in cell A4 to make it the active cell.

2. Hover over the right hand border of cell A4 until you see the
four headed arrow cursor shape.

4 109 lﬁ%[
5 10917 44
3. When you see this cursor shape hold down the <Shift> key

and double-click.

All cells to the right of cell A4, but within the range, are
selected.

4. Hover over the bottom border of the selected range until you
see the four headed arrow cursor shape.

Customer
Narch 2008 Bottom-Dollar Markets
flarch 2008 Romero yﬂ%‘nilln

5. When you see this cursor shape hold down the <Shift> key
and double-click.

The entire range (except the header row) is selected.

A B c D E &
1 Weekly Sales Report [ ]
2
3 |Invoice Mo Date Customer Country Total
4 10918 10 March 2008 Bottom-Dollar Markets Canada 1,700.81
5 10917 10 March 2008 Romero y tomillo Spain 429.92
6 10926 10 March 2008 Ana Trujillo Emparedados y helados Mexico 604.42
7 10929 11 March 2008 Frankenversand Germany  1,380.33
8 10934 11 March 2008 Lehmanns Marktstand Germany 587.50
9 10939 11 March 2008 Magazzini Alimentari Riuniti Italy 749.05
10 10939 11 March 2008 Magazzini Alimentari Riuniti Italy - 749.05 =
11 10925 12 March 2008 Hanari Carnes Brazil 558.29
12 10944 12 March 2008 Bottom-Dollar Markets Canada 1,204.75
13 10923 12 March 2008 La maison d'Asie France 879.83
14 10937 13 March 2008 Cactus Comidas para llevar Argentina 757.64
15 10947 13 March 2008 B's Beverages UK 258.50
16 10933 13 March 2008 Island Trading UK 1,081.71
17 10938 14 March 2008 QUICK-Stop Germany  3,209.95
13 10943 14 March 2008 Bottom-Dollar Markets Canada 5,195.85
19 10945 14 March 2008 Morgenstern Gesundkost Germany 287.88 B
20
21 Thsi report excludes sales to Asia and South Africa. |
4 4 » | Sheetl Sheet? ~Sheetd 1 [ | —— -0

You can also use this technique to select cells to the left of the
active cell or above the active cell.

Close the workbook without saving.

© 2008 The Smart Method Ltd
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Lesson 2-9: Re-size rows and
columns

1

note

Why are you calling
the pound sign a
hash?

You like potato and I like potahto,

You like tomato and I like tomahto; 3
Potato, potahto, tomato, tomahto!

Let’s call the whole thing off!

Song lyric by George Gershwin,
American Composer (1898-1937)

In the USA and Canada the
hash symbol is called the
pound sign or the number
sign.

In different USA/Canada
regions the single symbol has
different names because it can
be used to denote a number (as
in contestant #5) or as a weight

(as in 3# of butter). 4

Throughout this book I will
refer to the # as a hash because
that is the term used in most
other English speaking
countries.

First Quarter Sales and
Profit-4

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Notice that columns B, C, D and E are far too wide for their
contents. It would be useful to make them narrower to keep the
worksheet compact.

Re-size column B so that it is just wide enough to contain the
January sales figures.

Hover over the line separating the letters A and B until you see the
re-size cursor shape:

B+ C

When you see this shape, keep the mouse still and click and drag
to the left. Column B will re-size as you drag. Make it narrower so
that the values just fit in the column. Notice that the column width
in points and pixels are displayed as you drag (one point = 1/72
inch).

Pl =

Width: 8.86 (67 pixels)
A B + < D

1 |Sales and PruEit Report -éFirﬁt Quarter 2008

rofit Ry

2 H 3
3 Jan . Feb Mar
4 NewYork | 22,000 29,000 19,000

Re-size column B so that it is too narrow to contain the
January sales figures.

Notice that when the column isn’t wide enough to contain the
contents, hash signs are shown instead of values (if you're used to
hashes being called pound signs or number signs see the sidebar).

iy B = D
1 Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar
4 New York HHHHH 29,000 19,000

Automatically re-size column B so that it is a perfect fit for
the widest cell in the column.

Hover over the line separating the letters A and B until you see the
re-size cursor shape:

B+ C

When you see this shape, double-click to automatically re-size
column B.

74
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note

Other ways to re-size
rows and columns

You can also re-size rows and
columns using the Ribbon.

Click Home—>Cells>Format.

A drop-down menu appears.

— . 20T & Fing
|;—| FarmatT\ 2™ Filter~ Sele
Lag”

Cell Size

*[ RowHeight..
AutoFit Row Height

=3 Column Width...
AutoFit Column Width

Default Width...

You can use the Row Height and
Column Width settings to set the
row or column to a specific
number of points (a point is
1/72 of an inch).

You can also use the AutoFit
Row Height and AutoFit Column
Width options to automatically
size the row or column (you
achieved this more efficiently
with a double-click in the
lesson).

Default Width... often confuses
as it doesn’t appear to work.
This is because it re-sets all
columns to default width except
those that have already been re-
sized.

note

Making several
columns or rows the
same size.

Sometimes you will want to
make several columns exactly
the same width.

To do this, select the multiple
columns and then click and
drag the intersection of any of
the selected columns. This will
make each of the columns
exactly the same width.

Automatically re-size every column in the worksheet in one
operation.

1. Select every cell in the workbook by clicking the select all
button in the top left corner of the worksheet (you can also
select all by pressing <Ctrl>+<A>):

B

2. Hover over the intersection of any two columns until you see

R

the re-size cursor shape and then double-click.

Every column is now perfectly sized.

Notice that Auto-resize has done its job rather too well. Column A
is now wide enough to accommodate all of the text in cell Al.

.\ B C
1 Sales and Profit Report - First Quarter 2008

Automatically re-size column A so that it is only wide enough
to contain the longest city name (Los Angeles).

A B C D E
1 Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar Total

4 |Mew York 22,000 29,000 15,000 70,000
5 |Los Angeles 42,000 39,000 43,000

1. Select cells A4:A9.
2. Click Home—=>Cells>Format—-> AutoFit Column Width.

This time the column is automatically sized so that it is wide
enough to contain all of the text in the selected cells.

Notice that the text has spilled over from cell Al into the adjoining
columns B, C, D and E. This always happens when a cell contains
text and the adjoining cells are empty.

Manually size row 3 so that it is about twice as tall as the
other rows.

Do this in exactly the same way you re-sized the column but, this
time, hover between the intersection of rows 3 and 4 until you see
the re-size cursor shape, and then drag downwards.

1 Salesand Profit Report - First Quarter 2008

1 Height: 30.00 (40 pixels) |
' Jan Feb Mar

_} MNew York 22,000 29,000 159,000
Los Angeles 42,000 39,000 43,000

Auto-resize row 3 so that it is the same size as the other
rows again.

© 2008 The Smart Method Ltd
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Lesson 2-10: Use AutoSum to
sum a non-contiguous range

In the previous lesson, you learned how to view the sum of January and
March sales using the status bar. But how can you put that value onto the
worksheet?

Now that you have the hang of selecting non-contiguous ranges you can
use this in conjunction with your AutoSum skills to create a formula that
will calculate the total of a non-contiguous range.

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2 Enter the text Jan/Mar Sales in cell A10 and press the
<Tab> key.

The active cell moves to cell B10.

3 Re-size column A so that it is wide enough to contain the
text.

1. Hover over the line separating the letters A and B until
you see the re-size cursor shape:

A + B

2. When you see this shape, keep the mouse still and click
and drag to the right. Column A will re-size as you drag.
Make it wider so that the words Jan/Mar Sales comfortably
fit in the column:

Jan Feb Mar T
Mew York 22,000 29,000 19,000
Los Angeles 432,000 39,000 43,000

=D = RN [ = R, [ g T

London 18,000 20,000 22,000
Paris 35,000 26,000 31,000
Munich 12,000 15,000 13,000
USA Sales 64,000

10 |Jan/Mar Sales 1

M 4 b M| Sheetl -~ Sheet2 - Sheet3
Ready Calculate | Uﬁ@ | 10086 (=)

v

()

4 Click Home->Editing> (the AutoSum button).

An AutoSum appears in cell B10 but it isn’t anything like what we
want yet. It guesses that we simply want to repeat the value in the

USA Sales cell.
8 Munich .. 12,000 15,000 13,000
9 |USA Sales Lnuﬂ,ggﬁ
10 Jan/Mar Sales |=SUM{E} |
11 [ SUM(numberl, [numberZ], ...) |
M 4 » H| Sheetl -~ Sheet? . Sheet3
Point Calculate | 25 EEm T e (i

First Quarter Sales and
Profit-4 5 Select the range B4:B8 with the mouse.
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7

8

Hold down the <Ctrl> key and select the range D4:D8 with
the mouse.

Notice that the non-contiguous range B4:B8,D4:D8 is shown in the
AutoSum’s formula:

(@) 9~ )+

First Quarter Sales and Pro... M _ = X
LS b 4

chrr| Inse| Pagel Fcurn'l Datzl Re«ri-| in| Dewl Add-l@ - =
| SUM » (0 X « fx| =SUM(B4:B8,D4:D8) ¥

A B C D X

1 Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar 14
4 |New York T 22,000 | 29,000 7 19,000 | |
5 |Los Angeles E 42,000 E 39,000 E 43,000 E
& London E 18,000 20,000 E 22,000 {
7 Paris ! 35,000 | 26,000 | 31,000 |
& |Munich bo.. 120000 15000} 13,000
9 |USA Sales 64,000
EjanIMarSales |=SUM(B4:BS,D4:DS}
11 [ SUM{numberl, [number?], [number3], ... ]

4 4 F M

Point Calculate | P |

Press the <Enter> key or click the AutoSum button
again to view the sales for January and March in cell B10.

s a1

|r:!§'-| _ H ) - [ s First Quarter 5ales and Pro...M = x
= Haom | Inse | Pagel Fcurrrl Datzl Revi | Viwl DﬂrelAdd |® - g X
| c13 - | ¥
A B C D

1 Sales and Profit Report - First Quarter 2008

2

3 Jan Feb Mar =

4 New York 22,000 29,000 19,000

5 |Los Angeles 42,000 39,000 43,000

& |London 18,000 20,000 22,000

7 |Paris 35,000 26,000 31,000

2 Munich 12,000 15,000 13,000

9 |USA Sales 64,000

10 Jan/Mar Sales 257,000

M 4 v H | Sheetl ~Sheet? - Sheet3 I !
Ready Calculate | 2 | 00

Save your work as First Quarter Sales and Profit-5.

© 2008 The Smart Method Ltd
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Lesson 2-11: Use AutoSum to
quickly calculate averages

Excel’s AutoSum feature isn’t only restricted to addition. It is also able to
compute averages and maximum/minimum values.

In this lesson we’ll use AutoSum to calculate the average sales for each
month.

1 Open First Quarter Sales and Profit 5 from your sample files
folder (If it isn’t already open).

2  Delete cells E3:E4.
Select cells E3 and E4 and press the <Delete> key on your

keyboard.
3 Type the word Average in cell E3 and press the <Enter>
key.
CH Ck The cursor moves to cell E4:
HEI'E Feb Mar Average
29,000 19,000 |

¥ - J ; 4 Use AutoSum to create a formula that will show the Average
;?t E \jiél New York sales.

A T 1. (?lick Home~>Editing> AutoSum ->Drop down arrow (see
£7 Filter~ Select~ sidebar).
Editing A drop down menu is displayed showing all of the different

ways in which AutoSum can operate upon a range of cells:

Click Average.

2.
HAp &
- = _i}i' 3. Excel generates an Average function and inserts the cell range
2um B4:D4. This is exactly what we want:

Average

Count Mumbers | AUEFEEE

Max _ -AVERAGE (g

Min 1 AVERAGE(numberl, [number?], ...]

More Functions...

4. DPress the <Enter> key or click the AutoSum button again
to see the average sales for New York:

3 Jan Feb Mar Average
4 New York 22,000 29,000 13,000 23,333

5 Type the word Maximum in Cell F3 and then press the
<Enter> key.

6 Use AutoSum to create a formula in cell F4 that will show the
First Quarter Sales and Maximum New York Sales for this period.
Profit-5
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tip
Another way to bring back the
blue box showing a range is to

click the range in the Formula
bar.

1.

Place an AutoSum in cell F4 but this time, choose Max from the

drop-down menu.

This time we have a small problem. AutoSum is including the
average value (23,333) in the calculation.

lan Feb

Mar Average Maximum

I 22,000 29,000 19,000 23,333 :|=[".-"IAK|{

Select cells B4:D4 with the mouse

The marquee corrects and the average value in cell E4 is no

longer included.

MNew "r’l:lrkr 22,000 29,000 19,DDDI 23,333

—MAX(B4:D4)|

Notice that the Max function is now working with the range

B4:D4.

Press the <Enter> key or click the AutoSum button once
more to see the maximum sales the New York office managed
during the first quarter of the year:

3

4 Mew York

Jan

Feb Mar

22,000 29,000 19,000

Average Maximum

23,333

29,000

to bring back the marquee (shown as a blue box).

are included in the Sales total.

Change the words USA Sales in cell A9 back to Sales and
press the <Tab> key.

Press the <F2> key on the keyboard (or double-click cell B9)

Adjust the marquee using click and drag so that all offices

Notice that there is a small blue spot on each corner of the range.
These are called sizing handles.

1.

10 Save your work as First Quarter Sales and Profit-6.

Hover the mouse cursor over the bottom right (or bottom left)
sizing handle until the cursor shape changes to a double
headed arrow. It is really important that you see the double
headed arrow and not the four headed arrow or white cross.

4 New York
5 Los Angeles
6 London

‘ 22,000 |
42,000
2y

18,000

When you see the double headed arrow click and drag with
the mouse down to cell BS.

Press the <Enter> key or click the AutoSum button again.

7 |Paris
2 Munich
9 Sales

35,000
12,000
129,000

© 2008 The Smart Method Ltd
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iImportant

Formulas automatically
recalculate whenever any of the
cells in the formula change.

For example: If you were to
change the Paris sales to 45,000
this would cause cell B9 to re-
calculate to 139,000. Because B9
has changed this would, in
turn, cause the profit to re-
calculate to 56,000.

First Quarter Sales and
Profit-6

Lesson 2-12: Create your own
formulas

The AutoSum tool is very useful for quickly inserting Sum(), Average(),
Count(), Max() and Min() formulas into cells. Many Excel users never get
any further with their formulas than this.

In this session we’ll create our own formulas without the use of
AutoSum. You'll be amazed at how easy it is.

1

2

w

Open First Quarter Sales and Profit-6 from your sample files
folder (if it isn’t already open).

Select cells A10:B10 and press the <Delete> key once.
The previous contents of cells A10:B10 are removed.
Type the word Costs into cell A11 and Profit into cell A12.

Type the value 83,000 into cell B11 and press the <Enter>
key to move down to cell B12.

11 Costs
12 |Profit

83,000

Enter a formula into cell B12 to compute the profit made in
January.

1. Type: =B9-B11 into cell B12
2. Press the <Enter> key.
The profit for January is displayed:

9 Sales 129,000
10

11 Costs 83,000
12 |Profit 46,000

Enter the formula again using a better technique.

The method that you have just used to enter the formula works
just fine but it isn’t the best method. Sooner or later you will make
a mistake. For example you could easily type B8:B11 resulting in
an incorrect answer.

To eliminate such errors you should always select cell references
visually rather than simply type them in. You can visually select
cells using either the mouse or the keyboard. First we'll use the
mouse method.

1. Click in cell B12 and press the <Delete> key on the keyboard to
clear the old formula.

2. Press the equals <=> key on the keyboard.
3. Click once on the value 129,000 in cell B9.

80
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4. Press the minus <-> key on the keyboard.
5. Click once on the value 83,000 in cell B11.
6. Press the <Enter> key on the keyboard.

If you followed the above steps carefully you will see that you
have created the same formula but with a much lower possibility
of making a mistake.

7 Enter the formula again using the visual keyboard technique.

The very best Excel experts hardly use the mouse at all. You waste
valuable seconds every time you reach for the mouse.

Here’s the expert technique of visual selection via keyboard:

1. Use the arrow keys to navigate to cell B12 and then press the
<Delete> key on the keyboard to clear the old formula.

2. Press the <=> key on the keyboard.
3. Press the <Up Arrow> key three times to move to cell B9.
4. Press the <->key on the keyboard.
5. Press the <Up Arrow> key once to move to cell B11.
6. Press the <Enter> key on the keyboard.
8 Enter a formula that uses the multiplication operator.

This employer is very generous and pays the staff ten percent of all
profits as an incentive bonus.

In cell A13 type the words 10% Bonus and then press the <Tab>
key on the keyboard to move to cell B13.

9 Enter a formula that uses the multiplication operator.

important
The multiplication operator is not an X as you might expect but an
The Excel Operators asterisk (*). The other Excel operators are shown in the sidebar.
N You need to press <Shift>+<8> to enter an asterisk. If you are using
‘ a full size keyboard with a numeric keypad at the right-hand side
+ | Addition 142 you can also use the numeric keyboard’s <X> key.
- | Subtraction 75 Whichever key you use you'll still see an asterisk in the formula.

© | elpliEEen | G Use either the Mouse click technique or the visual keyboard technique

/ | Division 15/5 to enter the formula shown below into cell B13 and then press the
% | Percent 5% <Enter> key to see how much bonus was earned:
A | Exponentiation | 42 11 Costs 83,000

12 Profit
— *
13 |10% Bonus |_E12 1 I

11 Costs 83,000
12 Profit 46,000
13 |10% Bonus 4,600

10 Save your work as First Quarter Sales and Profit-7.
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trivia

The feature that Excel uses to
help you out with function calls
first made an appearance in
Visual Basic 5 back in 1996 and
had the wonderful name:
IntelliSense. The Excel

implementation is called
Formula AutoComplete.

In 1996 I was working in
Switzerland developing a ski-
school management
application. I was extremely
impressed by how easy
IntelliSense made my job. I
didn’t have to remember
hundreds of function names
any more.

I'was even slightly worried that
just about anybody could now
program (but, of course, I was
wrong).

Recently I was in London being
driven by a Hackney cab driver
(Hackney cab drivers know
every shortcut and back street
in London). He was worried
that Satellite Navigation would
now mean that anybody could
become a London cabbie.

Of course, he really had
nothing to worry about either!

note

Enabling and
disabling
AutoComplete.

As with so many other features,
Microsoft allows you to turn
this very useful feature off.

You’d never want to do this but
you may work on a machine
that has had Formula
AutoComplete switched off
and you need to turn it on
again.

Click Office->Excel
Options>Formulas and make
sure that the Formula
AutoComplete box is checked.

First Quarter Sales and
Profit-7

Lesson 2-13: Create functions
using Formula AutoComplete

1

2

Open First Quarter Sales and Profit-7 from your sample files
folder (if it isn’t already open).

Type the words USA Sales into cell A15 and European
Sales into cell A16.

Notice that the text European Sales spills over into column B
because column A isn’t wide enough to contain it.

Re-size column A so that it is wide enough for the words
European Sales to fit within the column.

You learned how to do this in: Lesson 2-9: Re-size rows and columns.

A B
15 USA Sales
16 |European Sales

Click into cell B15 and type =S into the cell.

Something amazing happens:

15 USA Sales =S |

16 |European Sales | (&) A
17 () SECOND

18 () SERIESSUM |
19 st

A list drops down showing every function in the Excel function
library beginning with S. This is a great new feature for Excel 2007
that Microsoft call Formula AutoComplete (if AutoComplete didn’t
display as expected see the sidebar).

You've already encountered the Sum(), Average() and Max()
functions courtesy of AutoSum.

You may be pleased (or dismayed) to know that there are over 300
functions in the Excel function library. The good news is that most
untrained Excel users only ever get to understand Sum() and
Average()!

When you typed =S Excel listed all functions beginning with S.
Continue typing: =SU.

Notice that the list now only shows functions beginning with SU
and look... there’s the SUM() function we need three down in the
list.

You could simply click on it with the mouse but let’s behave like
an Excel pro and do it with the keyboard.

Press the <Down Arrow> key twice to move the cursor over
the SUM function.

The Sum function now has a tip telling you what the function does:
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note

The syntax box

The Syntax box tells you what
arguments (sometimes called

parameters) the function needs.

The first argument has no
square brackets meaning that
you can’t leave it out. The
argument in square brackets is
optional.

For such a simple function as
SUM() the syntax box is hardly
needed but later we’ll discover
functions that require several
arguments and then the syntax
box will be invaluable.

A B
14
15 USA Sales
16 European Sales

64,000
65,000

10

11

15 |USA Sales [=su

16 European Sales | () SUBSTITUTE
17 @) sugTOTAL

18 ®

19 | Adds all the numbers in a range of cells

Display detailed information about the SUM() function.

The tip tells you a little about the SUM() function but to get the full
story press the <F1> key while SUM is still highlighted in the
dropdown list:

The Excel help system opens showing detailed help for the SUM()
function.

Read the help text if you are interested and then close the help
window.

Notice that Excel has now left you with only =SU in the cell.
Complete the formula by typing M(

=SUM(

| SUM({numberl, [number2], ...} |

Notice that a little box has appeared beneath the function call. This
is the Syntax (see sidebar for more information).

Select the cells that you need to sum (cells B4:B5) with the
mouse or keyboard.

If you want to be a real pro you should select them with the
keyboard. To do this:

1. Press the <Up Arrow> key repeatedly until you reach cell B4.

2. Hold down the <Shift> key and press the <Down Arrow> key
once to select cells B4:B5.

Type a closing bracket to complete the formula and then
press the <Enter> key.

The total USA sales are displayed in cell B15.

Use the same technique to create a SUM() function in cell
B16 to show the total European sales (cells B6:B8).

1. Click in cell B16.
2. Type=SU.

3. Press the <Down Arrow> key twice to move the cursor over
the SUM function.

4. Press the <Tab> key to automatically enter the SUM function
into cell B16.

5. Select the range B6:B8.

6. Type the closing bracket followed by the <Enter> key. The
formula should now be: =SUM(B6:B8).

Save your work as First Quarter Sales and Profit 8.

© 2008 The Smart Method Ltd
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Lesson 2-14: Use AutoFill for
text and numeric series

1

2

note

If you don’t see the
AutoFill handle
somebody has
switched it off

It’s almost certain that AutoFill

will be enabled on any

computer that you work on. It 4
is such a useful feature that you
wouldn’t want to disable it.

If you don’t see the AutoFill
handle (the black spot on the
bottom right hand corner of the
active cell) it’s because
somebody has switched
AutoFill off.

Bring it back like this:

Click Office->Excel
Options—>Advanced

In the first section (Editing
Options) check the box next to
Enable fill handle and cell drag
and drop.

First Quarter Sales and
Profit-8

Open First Quarter Sales and Profit-8 from your sample files
folder (if it isn’t already open).

Delete the text Feb and Mar from cells C3:D3.

Select cells C3:D3 and then press the <Delete> key on your
keyboard.

Make B3 the active cell.

Notice that there is a black border around the cell and a black spot
on the bottom right-hand corner. This is the AutoFill handle. If you
don’t see it, refer to the sidebar.

Autofill
[ 1 Handle

Hover over the AutoFill handle with your mouse until the
cursor shape changes to a black cross.

Many of my students have great difficulty with this when they try
it for the first time.

e You don’t want the four-headed arrow: + — that would move
the cell.

e  You don’t want the white cross: |:::Il" — that would select the
cell.

e You want the black cross: + — the AutoFill cursor.

Jlan
.-|_
When the black cross cursor is visible hold down the mouse
button and drag your mouse to the right to AutoFill the other
months: Feb and Mar.

Jan lceb Mar

i
22,000 29,000

00

Mar

Notice the tip that appears as you drag, previewing the month that
will appear in each cell.

In cell A18 type Monday and AutoFill down to cell A24 to
show the days of the week.

In cell B18 type the number 1 and in cell B19 type the
number 2.

Select cells B18 and B19.
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tip
You don’t have to enter two

numbers if you want to create a
numeric range.

If you simply type a number
into a cell and then AutoFill
while holding down the <Ctrl>
key you will automatically
generate sequential numbers.

9

10
11

12

13

14

15

1

o2

AutoFill down to B24 to create sequential numbers:

18 \Monday 1
19 |Tuesday 2
20 ‘Wednesday 3
21 |Thursday i |

In cell C18 type 9 and in cell C19 type 18.

Select cells C18 and C19.
g
oA8
|
AutoFill down to B24 to create the nine times table.
18 Monday 1 9
19 Tuesday 2 18

20 Wednesday 3 27

Use AutoFill to create sequential dates.

1. Type 01-Jan-08 into cell D18.

2. Type 02-Jan-08 into cell D19.

3. Select Cells D18:D19.

4. AutoFill down to D24 to create sequential dates.
Use AutoFill to quickly copy values.

Sometimes you will want to duplicate the value from one cell into
many others to the right of, left of, beneath, or above the active cell.

When a cell containing text is the active cell and it isn’t defined as a
fill series (the built-in fill series are days of the week and months of
the year), AutoFill will simply duplicate the contents of the cell:

Type the text Adjusted into cell E18 and then AutoFill it down as
far as cell E24.

The same text is now shown in each of the cells:

18 Monday 1 9 01-Jan-08 Adjusted
19 Tuesday 2 18 02-Jan-08 Adjusted
20 Wednesday 3 27 03-lan-08 Adjusted
21 Thursday 4 36 04-Jan-08 Adjusted
22 Friday 5 45 05-Jan-08 Adjusted
23 Saturday 6 54 06-Jan-08 Adjusted
24 Sunday 7 63 07-Jan-08 Adjusted

Save your work as First Quarter Sales and Profit-9.

© 2008 The Smart Method Ltd
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First Quarter Sales and
Profit-9

Lesson 2-15: Use AutoFill to
adjust formulas

AutoFill can save you a lot of time when extending or copying text and
number ranges. But the story’s not over yet.

AutoFill’s ability to copy and adjust formulas is one of the most powerful
tools in Excel’s impressive armory.

1 Open First Quarter Sales and Profit 9 from your sample files
folder (If it isn’t already open).

2  Consider the formula in cell B9.

Click onto cell B9 and view the formula displayed in the formula
bar (the formula bar is at the top right of the screen grab below).

B9 - f« | =sum(B4:Bs)
A B C D E
1 sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar Average
4 New York 22,000 29,000 19,000 23,333
5 |Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
& Munich 12,000 15,000 13,000
9

Sales 129,000 I

-
=]

The formula is =SUM(B4:B8). AutoSum created it for us in:
Lesson 2-3: Use AutoSum to quickly calculate totals. The formula uses
the SUM() function to add together the values in the range B4:B8.

Think about the formula that would work in cell C9 (the total sales
for February). It would be: =SUM(C4:C8). Similarly the formula
that would work in cell D9 (the total sales for March) would be
=SUM(D4:D8).

As we move to the right all that is needed is to increment the letter
for each cell reference in the formula and we’ll get the right answer
every time.

Now AutoFill is very clever and realizes this. When we AutoFill a
cell containing a formula to the right, AutoFill increments the
letters in each cell reference.

Most of the time that is exactly what we want.
3 AutoFill cell B9 to the right as far as cell D9.

You may see a row of hashes in Cell C9. This is because the value
is too wide to fit in the cell. If this is the case, AutoFit the column
using the skill learned in: Lesson 2-9: Re-size rows and columns.
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E F
Average Maximum
23,333 23,000
41,333 43,000
20,000 22,000
30,067 35,000
13,333 15,000

The correct answers for Feb and Mar sales are shown on the
worksheet. Click on the Feb total cell (C9) and look at the formula
in the formula bar.

9 - £ | =suM(ca:Cs)
A B C D E
3 Jan Feb Mar Average
4 New York 22,000 29,000 19,000 23,331
5 LosAngeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 Sales 125,000 § 129,000 ! 128,000
i’

You can see that AutoFill has done its work perfectly, creating a
sum of the values in cells C4:C8. Our five branches have sold
exactly the same amount in both January and February, but a little
less in March.

Consider the formula in cell E4.

Click onto cell E4 and view the formula displayed in the formula
bar.

E4 - fe | =AVERAGE(B4:D4)
A B C D E

Jan Feb Mar Average |
MNew York 22,000 29,000 19,000 23,333 .I

Los Angeles 42,000 39,000 43,000
London 18,000 20,000 22,000

3
4
3
5]

The formula is =AVERAGE(B4:D4). AutoSum created it for us in:
Lesson 2-11: Use AutoSum to quickly calculate averages.

Think about the formula that would work in cell E5 (the total sales
for Los Angeles). It would be: =Average(B5:D5). Similarly the
formula that would work in cell E6 (the total sales for London )
would be =Average(B6:D6).

As we move downward all that is needed is to increment the
number for each cell reference in the formula.

AutoFill cell E4 down to ES8 to see the Average sales for
each branch.

AutoFill cell F4 down to F8 to view the maximum sales for
each branch.

Save your work as First Quarter Sales and Profit-10.

© 2008 The Smart Method Ltd
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Lesson 2-16: Use AutoFill
options
Sometimes AutoFill begins to misbehave and actually gets in the way of

efficient work by wrongly anticipating what you need.

1 Open First Quarter Sales and Profit-10 from your sample
files folder (If it isn’'t already open).

2 Incell F18 type the date 1-Jan-2009.
3  AutoFill down as far as cell F24.

The cells are populated with sequential dates:

A B C D E F
18 Monday 1 9 01-lan-08 Adjusted  01-Jan-09
19 Tuesday 2 18 02-Jan-08 Adjusted  02-Jan-09
20 Wednesday 3 27 03-Jan-08 Adjusted  03-Jan-09
21 Thursday 4 36 04-lan-08 Adjusted  04-Jan-09
22 Friday 5 45 05-Jan-08 Adjusted  05-Jan-09
23 |Saturday 6 54 06-Jan-08 Adjusted  06-Jan-09
24 Sunday 7 63 07-Jan-08 Adjusted  07-Jan-09

4 In cell G18 type the date 31-Mar-2009.
5  AutoFill down as far as cell G24.

At some time you'll need to add transaction dates to a worksheet
and will have four or five entries with the same date.

AutoFill is perfect for eliminating the need to re-type the date for
each transaction, but its insistence upon incrementing the date
every time could be very frustrating.

Fortunately we can change the default behavior.

=5
6 Click the Auto Fill Options Smart Tag “* at the bottom right
corner of the filled cells.

03-Apr-09
04-Apr-09
05-Apr-09
06-Apr-09
=
O Copy Cells
(5" Fill Series
0 Fill Fermatting Only
' Fill Withgut Fermatting
O Fill Days
O Fill Weekdays
' Fill Months
' Fill Years

First Quarter Sales and
Profit-10
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7 Click Copy Cells to tell AutoFill not to increment the date.

The purpose of the Fill Formatting options will be clear later in the
course when you have completed: Session Four: Making Your

Worksheets Look Professional.

Here’s what the other options will do:

Copy Cells  Fill Series ‘ Fill Days  Fill Weekdays Fill Months Fill Years
This is what The default The date Because 3¢ April | Normally this would The same
we just did. for dates that | increments | 2009 is a Friday show the same day calendar day
. . | include the by one day | the weekend number for each is shown for
The first cell is . . .
. day. at a time. days are omitted | month. In this each
copied to the 1th ) le th b ;
other cells. The date and the series example, there are subsequen
. jumps from 3r¢ only 30 days in two of | year.
increments . . .
April to 6t April. | the months so 30t is
by one day at )
. shown instead of 31st.
a time.
31-Mar-09 31-Mar-09 31-Mar-09 31-Mar-09 31-Mar-09 31-Mar-09
31-Mar-09 01-Apr-09 01-Apr-03 01-Apr-09 30-Apr-09 31-Mar-10
31-Mar-09 02-Apr-09 02-Apr-09 02-Apr-09 31-May-09 31-Mar-11
31-Mar-09 03-Apr-09 03-Apr-09 03-Apr-09 30-Jun-09 31-Mar-12
31-Mar-09 04-Apr-09 04-Apr-09 06-Apr-09 31-Jul-09 31-Mar-13
31-Mar-09 05-Apr-09 05-Apr-09 07-Apr-09 31-Aug-09 31-Mar-14
31-Mar-09 06-Apr-09 06-Apr-09 08-Apr-09 30-5ep-03 31-Mar-15
—— 8  Access fill options using right-click AutoFill.
Copy Cells
Fill Series 1. Click again on cell F18 to make it the active cell.
::: f:i::ztt”zsnr:;mg 2. AutoFill once more but, this time, hold down the right mouse
R button.
Fill Days
01-Jan-09 GillWeekday 2 When you release the mouse button you are presented with
02-Jan-05 Fill Months the AutoFill options (see sidebar).
03-lan-09 Fill Years
04-Jan-09 This method is preferred to the Smart Tag method because it is
05-Jan-09 faster (one click instead of two)!
06-Jan-09 Series...
07-Jan-09 = 9  Change back to Fill Series or Fill Days.

In this example Fill Series and Fill Days produce exactly the same
result.

10

Save your work as First Quarter Sales and Profit-11.

© 2008 The Smart Method Ltd
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Lesson 2-17: Speed up your
AutoFills and create a custom
fill series

In this lesson we’re going to learn some AutoFill techniques that will
massively speed up your efficient use of the AutoFill feature.

1 Open First Quarter Sales and Profit-11 (if it isn’t already
open).

2 Delete the contents of cells G18:G24.
3  Type 31-Mar-09 into cell G18.

A B C D E F G

17

18 Monday 1 9 01-lan-08 Adjusted 01-Jan-09 31-Mar-09
15 Tuesday 2 18 02-)an-08 Adjusted 02-Jan-09

20 |\Wednesday 3 27 03-Jan-08 Adjusted 03-Jan-09

21 Thursday 4 36 04-Jan-08 Adjusted 04-Jan-09

22 |Friday 5 45 05-Jan-08 Adjusted 05-Jan-09

23 Saturday 6 54 06-Jan-08 Adjusted 06-Jan-09

24 sunday 7 63 07-)an-08 Adjusted 07-Jan-09

4 Double click the AutoFill handle to automatically fill cells
G19:G24.

This is a real master tip!

Hover over the AutoFill handle (the black spot at the bottom right
hand corner). When you are sure that you have the correct black
cross cursor shape, double click to automatically fill down.

Dl-Jan-DBI 31-Mar-DB+L —DOUbIE'CliCk 01-lan-09 31-Mar-09
02-Jan-03 02-lan-09 01-Apr-09
03-Jan-09 the black cross... | 03-1an-09 02-apr-0s
04-Jan-09 04-Jan-09 03-Apr-09
05-Jan-03 A_rld be | 05-)an-0S 04-Apr-09
06-Jan-09 06-Jan-09 05-Apr-09
07-Jan-09 amazed 07-Jan-09 06-Apr-09

5 Delete all of the dates from cells G19:G24 leaving only the
date 31-Mar-09 in cell G18.

6 Hold down the <Ctrl> key and AutoFill down as far as G24
by dragging the AutoFill handle down with the mouse.

Because you held the <Ctrl> key down AutoFill simply copies the
cell instead of creating a series of values.

First Quarter Sales and
Profit-11
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z First Quarter Sales and Profit-10.xlsx - Microsoft Excel & = x
Page Layout  Formulas Data Review  View Developer  Add-Ins '@) - 7 X
(= i | ¥
B & D E F e} K
1 9 01-Jan-08 Adjusted 01-Jan-09 31-Mar-09
2 13 02-Jan-08 Adjusted 02-Jan-09 31-Mar-09
3 27 03-Jan-08 Adjusted 03-Jan-09 31-Mar-09
4 36 04-Jan-08 Adjusted 04-Jan-09 31-Mar-09
5 45 05-Jan-08 Adjusted 05-Jan-09 31-Mar-09 i |
& 54 06-Jan-08 Adjusted 06-Jan-09 31-Mar-09 1
7 63 07-Jan-08 Adjusted 07-lan-09 31-Mar-09
eet? . Sheet3 - ¢J 400 I m I
[EEE =T e O

This is even faster than using the right-click method when you
want to prevent the date incrementing.

Click Office=>Excel Options—>Popular.

In the Popular category under Top options for working with
Excel click the gray Edit Custom Lists... button.

| Edit Custom Lists... |

The Custom Lists dialog appears.

9 Click in the List entries window and add four custom list
entries: North, South, East and West.

" Custom Lists -7 ==

Custom Lists

Custom |ists: List entries:

NEw LT =] [nortn -
Mon, Tue, Wed, Thu, Fri, Sat, S South

Monday, Tuesday, Wednesday, East
Jan, Feb, Mar, Apr, May, Jun, ] West|
January, February, March, April

Press Enter to separate list entries,
Import list from cells; 5

5.5 Import
NDrth OK l [ Cancel ]
South
East 10 Click the OK button.
West 11 Type North in any cell and AutoFill down.
;JCII"-ttﬁ As you AutoFill the custom list entries appear in the worksheet.
ou
East 12 Delete the North, South, East, West... cells from the
worksheet.
West

13 Save your work as First Quarter Sales and Profit-12.
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First Quarter Sales and
Profit-12

Lesson 2-18: Use the zoom
control

Zooming is used to magnify or reduce the worksheet. If you have a lot of
rows in a worksheet and have good eyes you might want to zoom out
sometimes to see more of the worksheet on one screen.

1 Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn't already open).

2 Zoom in and out of a worksheet using the mouse wheel.
The fastest way to zoom a worksheet is by using the mouse.

Most mice these days have a wheel in the middle of the buttons. To
zoom using this wheel hold down the <Ctrl> key on the keyboard
and roll the wheel to zoom in and out.

3 Zoom in and out of a worksheet using the zoom control.
The zoom control is at the bottom right of your screen,

Click and drag on the zoom control slider to zoom in and out of
your worksheet. You can also zoom by clicking the plus and minus
buttons on either side of the Zoom control.

Click here to
Display the Zoom
dialog

Zoom out

Zoom in

Click and
drag

to zoom

|1D{}%Ej 0 @.:E

4  Select cells A3:D9.

We're going to use the zoom dialog to make this selection
completely fill the screen.

5 Click the left hand side of the zoom batr.
The zoom dialog is displayed.
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6

Select the Fit Selection option button and click the OK

button.

Zoom
Magnification
1 200%
() 100%
(7)) 75%
() 50%
) 25%

(71 Custom

ni

2 ==

+ 206 | %%

Ok

|

Cancel

The worksheet is zoomed so that the selected cells completely fill

the screen.

0 e o s o e o
— -~

A B & D L

1 Sales and Profit Report - First Quarter 2008

2

3 Jan Feb Mar

4 |New York 22,000 29,000 19,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000
9 |Sales 129,000 129,000 128,000

Zoom back to 100% using the Ribbon.

You'll probably find the zoom bar to be the quickest and most
convenient way to zoom, but the View Ribbon also has a Zoom
group containing three buttons:

L 00| _::\J
foom 100% JFoomto
Selection
Zoam

Use the 100% button to restore the screen to normal.

© 2008 The Smart Method Ltd
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Lesson 2-19: Print out a
worksheet

We aren’t going to explore every option for preparing and printing a
worksheet in this lesson. Printing is such a huge subject that we devote a
whole session to it in: Session Seven: Printing Your Work.

This lesson only aims to teach you the bare minimum skills you need to
put your work onto paper.

1 Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn’t already open).

A B C D E F G
1 |Sales and Profit Report - First Quarter 2008
2
3 Jan Feb Mar Average Maximum
4 |New York 22,000 29,000 19,000 23,333 29,000
5 |Los Angeles 42,000 33,000 43,000 41,333 43,000
& London 18,000 20,000 22,000 20,000 22,000
7 Paris 35,000 26,000 31,000 30,667 35,000
g |Munich 12,000 15,000 13,000 13,333 15,000
9 |Sales 129,000 129,000 128,000
10
11 Costs 83,000
12 Profit 46,000
13 |10% Bomnus 4,600
14
15 |USA Sales
16 European Sales
17
18 Monday 1 9 01-Jan-08 Adjusted 01-Jan-09 31-Mar-09
19 Tuesday 2 18 02-Jan-08 Adjusted 02-Jan-09 31-Mar-09
20 Wednesday 3 27 03-Jan-08 Adjusted 03-Jan-09 31-Mar-09
21 Thursday 4 36 04-Jan-08 Adjusted 04-Jan-09 31-Mar-09
22 |Friday 5 45 05-Jan-08 Adjusted 05-Jan-09 31-Mar-09
23 Saturday 6 54 06-Jan-08 Adjusted 06-Jan-09 31-Mar-09
24 | Sunday 7 63 07-Jan-08 Adjusted 07-Jan-09 31-Mar-09

2 Click the Office button at the top left of the screen D‘/

3 Hover the mouse cursor over the Print button at the left of
the dialog.

4 Click Print Preview from the menu at the right hand side of
the dialog.

5 A preview of the printout is shown on screen:

First Quarter Sales and
Profit-12
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Sales and Profit Report - First Quarter 2008

lan Feb Mar Average

New York 22,000 23,000 15,000 23333
Loz Angeles 42,000 33,000 43,000 41333
London 18,000 20,000 22,000 20,000
Pariz 35,000 26,000 31,000 30667
Munich 12,000 15,000 13,000 13333
Sales 125000 123000 123,000

Costz 83,000

Profit 45,000

10% Bonus 4,600

USA Sales -
European Sales

Monday 1 9 01-lan-08 Adjusted
Tuesday 2 18 02-lan-08 Adjusted
Wednesday 3 27 03-Jan-08 Adjusted
Thursday 4 36 04-lan-08 Adjusted
Friday 5 45 05-lan-08 Adjusted
Saturday 6 54 06-lan-08 Adjusted
Sunday 7 &3 07-lan-08 Adjusted

Maximum
23,000
43,000
22,000
35,000
15,000

01-Jan-08 31-Mar03
02-Jan-08 31-Mar09
03-lan-02 31-Mar-08
04-Jan-08 31-Mar03
05-Jan-08 31-Mar09
0&-lan-08 31-Mar-03
07-lan-08 31-Mar03

Click on the page to see the zoom feature working.

Each time you click on the page the page zooms in and out.

screen.

=
Click the Print button “= at the top left of the Print Preview

If you don'’t see this icon at the top of the Print Preview window it
is because you have hidden the Ribbon. Unhide it by double-
clicking the Print Preview Ribbon tab.

The print options dialog appears:

Print
Printer
MName: cj_‘% HP LaserJet 2420 PCL 6
Status: Idle
Type: HP Laserlet 2420 PCL &
Where: DOT4_001
Comment:
Print range
o Al
) Page(s) Erom: = To: =
Print what
) Selection _) Entire workbook

@ Active sheet(s) Table

|:| Ignore print areas

Freview

-]

Copies

Mumber of copies:

@I [ callate

-7 s

Find Printer...

[ Print to file

s

| ok

| | cancel

8

Click the OK button to print your work.

For this simple worksheet there’s no need to change any of the
options but you can probably figure out what most of them are for.

© 2008 The Smart Method Ltd
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10

11
12

Open a new workbook.
Use AutoFill to put the three months Jan, Feb, and Mar into cells A4:A6.

Using only the keyboard add the following data:

A B C D E
1 | Profit Analysis
2
3 London  Paris Mew York Average
4 lan 2,500 3,100 2,300
5 Feb 2,200 2,700 2,600
6 |Mar 2,100 2,600 2,800
7 |Total

Use AutoSum to compute London’s total profit for Jan/Feb/Mar in cell B7.
Use AutoSum to compute the average January profit in cell E4.

Use AutoFill to extend the London total in cell B7, to the Paris and New York totals in cells C7
and D7.

Use AutoFill to extend the January average profit in cell E4, to the February and March average
profits in cells E5 and E6.

Select all of Column A and all of Column E (at the same time) and bold face the values in them.

Select row 3 and row 7 (at the same time) and bold face the values in them.

A B C D E
1 Profit Analysis
2
3 London  Paris New York Average
4 |lan 2,500 3,100 2,300 2,633
5 Feb 2,200 2,700 2,600 2,500
& Mar 2,100 2,600 2,800 2,500
7 |Total 6,800 8,400 7,700

Select cells B4:B6 and cells D4:D6 at the same time and then read the total London and New York
sales figure for Jan, Feb and March from the summary information displayed on the status bar.

Select cells B4:D6 and zoom the selection so that these cells fill the screen.

Save your work as Exercise2-End.

If you need help
slide the page to
the left
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These are the four questions that most students find the most difficult to remember:

1. Hover over the
centre of cell B4 so that
you see the white
cross cursor shape.

2,500

2. Click and drag
down to cell Bé6.

3. Hold down the
<Ctrl> key.

4. Hover over cell D4
until you see the white
cross cursor shape.

5. Click and drag
down to cell Dé.

This was covered in:
Lesson 2-7: Select non-
contiguous cell ranges
and view summary
information.

1. Click on the column
A header.

4 A | B

Profit Analysis

2. Hold down the
<Ctrl> key.

3. Click on the column
E header.

4. Click
Home—>Font>Bold.

Calibri

This was covered in:
Lesson 2-6: Select
adjacent and non-
adjacent rows and
columns.

1. Click in cell B7.

2. Click Home->Editing—=>
Autosum (Q4).

T b A

Sort & Find &
2 Clear - Filter ~ Select =

Editing

OR

Click Home->Editing—>
Autosum-> Average (Q5).

|E Autosumf=
% 5um
Averpge

Count My

3. Either press the <Enter> key
or click the Autosum button
again.

This was covered in: Lesson 2-3:
Use AutoSum to quickly calculate
totals.

1. Type Jan into cell
A4 and press the
<Enter> key.

2. Click cell A4 once
to make it the active
cell.

3. Hover the mouse
cursor over the
bottom right corner
of the cell until you
see the black cross
cursor shape.

Jan

4. Click and drag
down to cell Aé6.

This was covered
in: Lesson 2-14: Use
AutoFill for text and
numeric series.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1 Refer to: Lesson 2-2: Create a new workbook and view two workbooks at the same time.
3 Refer to: Lesson 2-1: Enter text and numbers into a worksheet.

6 Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

7 Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

9 Refer to: Lesson 2-6: Select adjacent and non-adjacent rows and columns.

11 Refer to: Lesson 2-18: Use the zoom control.

12 Refer to: Lesson 1-5: Save a workbook.
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End piece

Please provide some feedback

Thank you for completing my Free Excel 2007 course.

Perhaps now you will wish to teach others what you have learned yourself. At The Smart Method we use
this course to teach our classroom Excel courses. Feel free to print this course out and use it in any way you
wish to spread a greater understanding of Excel 2007.

If the course has helped you I don’t want your money but I DO want your feedback.

There’s a facility at the web site www.LearnMicrosoftExcel.com where you can pass on any comments you
may have or just Email me at feedback@learnMicrosoftExcel.com.

You'll really brighten up my day if you just say “Hi, thanks for the course” or something like that.

You’'ll make my entire week though, if you tell me what was wrong with the course. I really want to know
about typos, inaccuracies or anything at all that you found confusing or difficult. All of your feedback will be
incorporated into future revisions of the CW rsoiwi’fh zur help, it will get better and better.

mart

Looking forward to hearing from you.

My books

If you want to improve your Excel skills further (and there’s a huge amount more to learn) I have two Excel
books in print (or shortly to be in print if you are reading this prior to October 2008).

They are both available from amazon.com, amazon.co.uk and any bookshop in the world. There’s a link to
the right Amazon page on the website and the current status if either is not yet published.

My first book includes the two sessions you have completed along with five more. It is called Learn Excel
2007 Essential Skills with The Smart Method. The second book: Learn Excel 2007 Expert Skills with The Smart
Method covers all of the skills you need to be a true expert.

Learn Learn

Excel 2007 Excel 2007
Essential Skills Expert Skills

With The Smart Method With The Smart Method

Our unique teaching n empower you with every skill Our unique teaching method will enable experfenced Excel 2007
you need o be pf Vi h th users to fak features to the m
By the end of the course you'll be able fo create sophisticated
worksheets that incorporate all of Excef 2007's advanced features.

SALES BY CATEGORY

. . . Companion Web site has all book code ;
n Web site has all book code . at: www.leamMicrosoftExcel.com Mike Smart
wleamiicrosoftExcel.com Mike Smart
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